Your Personal Web Page with HTML and CSS

The two most important concepts which make the World-Wide Web work are HTTP and HTML. Here is what they mean:

The Hypertext Transport Protocol (HTTP) is a computer networking protocol, like TCP-IP, which lets computers talk to each other. In a nutshell,

· TCP-IP is the base language which all computers on the Internet use to communicate;

· HTTP is the special language used by servers on the World-Wide Web. 

We call these special languages protocols. Since HTTP and TCP-IP are used by client and server programs to talk to each other, you don’t need to be able to understand these languages. Your operating system knows how to “talk” TCP-IP, and your Web browser program knows how to “talk” HTTP.

All of the Web pages you see, with the exception of any pages on your own system, are hanging out on somebody’s server. If you want to put your Web page masterpiece (the one you are about to create in this lab) out on the Internet for everyone to admire, you have to find an HTTP server for it. This server will hopefully be a campus machine on which you have a free account, or it could be a commercial server. If you have a paid account on an Internet Service Provider (ISP), your monthly fee probably includes space to put your Web pages.

To make a long story short (too late!), only techie types who actually run their own servers need to know anything about HTTP. 

The Hypertext Markup Language (HTML) is a different story. HTML is the actual language in which Web pages are written. So if you want to write Web pages, it helps to learn HTML. Fortunately, HTML is a lot easier to learn than programming languages such as BASIC or Java. It’s more fun, because you can see the visual output immediately.

Is this really necessary?

To be honest, you can create Web pages without knowing a bit of HTML. You can get specialty Web creation software such as Macromedia Dreamweaver, or simply write your document in Microsoft Word and save it as HTML. The program will handle all the details of writing correct HTML. But if you ever want to be any good at this, it helps to know a little HTML. After you get out of these lab exercises, you can decide for yourself whether you want to learn any more HTML or not. So let’s get started.

How to write your own HTML

You can write your own HTML with a very simple editor such as Notepad. Do NOT use Microsoft Word, because Word will insert all kinds of extra formatting characters into your HTML code. In our CS labs we will use a helpful program called Notepad2, a little bit stronger text editor than Notepad, which knows enough HTML to help us avoid silly mistakes.

Getting Started

Let’s create a shortcut to Notepad2 so that we can access it from our Desktop.  Here’s how to do that:

1. Click the Start button and click on Computer.

2. Double click on the C: drive icon.

3. Double click the Program Files folder.

4. Scroll down the installed program folders list until you see notepad2 and double click it.

5. Click the Views down-list arrow and select Details (see the image below)
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6. Notice one of the file Types is “application”.  Right-click on the application file and select Send To → Desktop (create shortcut).

7. That’s it!  Go to your desktop and you should find your newly created Shortcut.  
Double click your shortcut to launch Notepad2. Let’s clue in Notepad2 that we’re going to be making HTML files.  From the menu bar, choose View, Syntax Scheme and pick Web Source Code. This tells Notepad2 that we will be typing HTML documents. 
Type in the following:

<HTML>

Hey look! I'm a Web page!

</HTML>

The stuff in angle brackets is our first example of a tag, which is the basis of HTML. The first line basically says "Start being HTML" and the last line says "Stop being HTML." 

Saving your first Web page

Save this on your I: drive as MyFirstPage.html. Be sure to add the ‘.html’ extension to the filename so that your Windows system will recognize this file as a Web page. 
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Alternatively, you can select Web Source Code as the “Save as type” and it will add the extension .html for you.
Do not exit Notepad2 yet! We have a lot of tweaking to do on this primitive example.

Web Browsers

In this exercise we will be switching back and forth between two or three windows as we develop your Web page. The editor window you just used contains the HTML source code for the page. To see what the page actually looks like on the Web, you need a Web browser. 

On our lab computers, we have Mozilla Firefox, and Internet Explorer. On other machines, you may see additional browsers such as Opera or Netscape Navigator.  We will use Mozilla Firefox, because it has some useful Web development tools. However, your work should display properly in all browsers – if you follow the guidelines in these notes!
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From the Start button, launch Mozilla Firefox. From the File menu choose Open File and browse to find the file MyFirstPage.html. You will see something that looks like the rather unimpressive specimen on the right. 

From here on, we will be adding one feature at a time until this Plain Jane page has become your personal statement. This manual will show you some of the techniques for snazzing up your page, and point you to references where you can learn the rest. But the content, your artistic presentation, and whether you choose to have a personal presence of the Web is up to you.

For our first enhancement to this plain page, let’s add a title. Click back on your Notepad2 window. Notice you already have some of these lines in your code.  Add only the highlighted portions shown below:

<HTML>

   <HEAD>

      <TITLE>CSCI 1100 Web page Example</TITLE>
   </HEAD>
   <BODY>
     Hey look! I'm a Web page!

   </BODY>
</HTML>

Here we have added three more pairs of tags, <HEAD>…</HEAD>, <TITLE>….</TITLE>, and <BODY></BODY>. The new tags are nested inside the original pair.  Here is what they mean:

1. The document head is the part of the Web page that does not show up in the browser window. The head includes information about the web page, such as its title.

2. The title of your Web page will be displayed in the blue bar at the top of your browser.  

3. By the body we mean the part of the Web page which you see inside the browser viewing window.

Note that we have indented the code to emphasize how the tags are nested. Indentation is purely for aesthetics and readability. 
In Notepad2, choose File/Save to save this new and improved version of the file. 

Now click back to the browser window. What gives? Your browser window is still displaying the same title bar. That’s because it doesn’t know that we’ve just updated the page. Give your Browser a wake-[image: image19.png]Kutesy Koala's Home Page
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up call by clicking the Refresh button. 
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which will not make any visible changes.  The title, however, shows up in the top blue title bar of the browser window (see the image at right).

We will continue in this fashion, using Notepad2 (the editor) to add features to the HTML file and Internet Explorer  (the browser) to see the results.

Using the Mozilla DOM Inspector

Click on Tools then select the DOM Inspector. You will see a tree-view display that contains the single [image: image22.png]My Incredible
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item, document. Click on the [-] navigation tags to open the tree. You should see a display like the picture to the left.

What is DOM Explorer telling us? DOM stands for Document Object Model – a system for interpreting your HTML document as a collection of objects. According to the display, our document object contains an HTML object, which contains a HEAD object and a BODY object. Also, the HEAD object contains a TITLE object.

As we continue improving our Web page, we will use DOM Explorer to verify that the internal object structure of our document is as we think it is. Small errors in coding, such as leaving off an end tag, can have severe consequences!

Validating your Web Page

Validation is a mechanical process to verify that your page follows the formally defined rules of HTML grammar. These rules can be picky, just as when someone makes you use precisely correct English grammar. We use the validation check for two reasons:

1. Checking the grammar can reveal subtle errors in our HTML source code;

2. HTML code that complies with the formal grammar is much less likely to suffer browser incompatibility problems: pages that display fine in one browser, but look terrible in a different browser.

To use the validator, 

1. Open a new browser tab  from the File menu. 

2. Navigate to http://validator.w3.org, the validator page. 

3. Click the Validate by File Upload tab. 

4. Use the Browse button to find your file, and then click the Check button to validate the file.

Your first attempt will yield an error message similar to the one shown below. Recall that all computer data are encoded as bits, including the character data that make up an HTML file. The validator complains that it is unable to “extract” any information on what character encoding you want to use, and is “falling back” to UTF-8, better known to us as the good old ASCII encoding.
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To clue the validator in to what we’re doing, copy and paste the following highlighted lines (the DOCTYPE and META lines) into your MyFirstPage.html file. Make sure the DOCTYPE line is the first line in your code, and the META line goes inside your header, i.e. between <HEAD> and </HEAD>.  If you don’t feel like typing [image: image23.png]EIHTML
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this out, feel free to copy and paste from the Web version of this document.
[image: image4]
Press the Reload button on your browser. The complaints about character encoding should disappear (but there are still other errors in the code that we will fix in a second…); if they don’t, you may need your TA to help you tweak the quotes and other little bitty characters in your file.

 When you have gotten rid of these picky errors, you will be down to the real HTML errors, as shown below (exact line numbers and column numbers may vary with what we show.  Don’t worry).
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What is the validator saying? Well, it clearly says you are not writing valid code! But what is wrong?

First of all, the error is on line 8 (your line number may vary slightly from mine). Go back to Notepad2, open the View menu, and turn on Line Numbers.
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Now read the error message closely. Validator suggests that you might have put text directly into the body, and that is exactly what we did. The suggested remedy is to put the text into a container element, such as a paragraph element.

Let’s try it! In Notepad2, enclose the offending text in <P> </P> tags, as shown at the right. Save the page and reload Validator again. This time you should see the welcome message shown below. Yippee!
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Click on the Mozilla tab that contains your page and click the Reload button. The display should stay [image: image25.png]rodefiame.
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exactly the same. 

Now use DOM Inspector once again. You will need to close the DOM Inspector window and reopen it from the Tools menu.  Navigate to the BODY element. You should see that the BODY element now contains a P element, which contains the text. The rules of HTML 4.01 don’t allow text to be in the body of the text without being ‘wrapped’ in a container element such as a paragraph.

Headings

Now it’s time to explore ways of dressing up the text inside the HTML body. The HTML heading tags put text in a large, bold font. Headings come in various sizes from level 1 (biggest) to level 6 (smallest). Let’s test them out by editing the page as follows. Add just the highlighted lines to your current example webpage. Note that every header tag H1, H2, etc. has a matching closing tag /H1, /H2, etc.

	<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN"  "http://www.w3.org/TR/html4/strict.dtd">

<HTML>

<HEAD>

<META http-equiv="Content-Type" content="text/html; charset=utf-8">

<TITLE>CSCI 1100 Web page Example</TITLE>

</HEAD>

<BODY>

<H1>My Incredible</h1>

<H2>Wonderful</h2>

<H3>well, kind of neat</h3>

<H4>actually, rather ordinary</h4>

<H5>pretty lame, to be honest</h5>

<H6>World-Wide Web Page</h6>

<P>Hey look! I'm a Web page!</P>

</BODY>

</HTML>
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Refresh your webpage in the browser.  Your result should look like the page to right.  Use DOM Inspector once again. You will see that H1, H2, etc. are shown as container elements.

Click on the Validator tab and reload it. Your new page should still be valid HTML 4.01 Strict. We are jammin’ now!

In this example we have also mixed the case of the special HTML tags. That is, we used "H1" to start a level-1 heading but "h1" to end it, for example. HTML is case-insensitive, meaning that it doesn’t care whether or not you use capital letters in the tags. The new language XHMTL, which is the “next generation” version of HTML, requires lower case tags. We will use lower case tags in the examples that follow this one.
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What if we make a mistake?

All right, I know you don’t mistakes. But let’s just pretend for a moment that you at least know someone who does. What’s going to happen if one of these weird little symbols gets left off?

Let’s show you an example. Go back to Notepad2 and change the H2 in the seventh line to N2. This is a common typographical error since the two keys are right next to each other on the keyboard. Now save the file, and click the Refresh button on the web browser. Everything looks fine except the second line.

How can you tell what’s gone wrong? 

· You can see the effects of the busted HTML tag. In this case, everything works except the level 2 header “Wonderful”. This suggests that the error is in the H2 tag.

· Go to the Validator tab and click Reload. Validator will fuss at you about the undefined N2 element.

Go back to Notepad2 and fix the error. Reload your page to make sure it’s correct.

We encourage you to validate your pages frequently, in fact, every time you make a change to your file. The W3C validator page gives you some code to put on your web page, creating a W3C-compliance logo that also serves as a check-validity button. To get full credit on your course Web page, it must use valid HTML 4.01 Strict.

Controlling alignment with the Division tag

Our page might look less boring if the lines were not all aligned to the left on the page. This is easy to fix with the <DIV> and </DIV> tags. These tags mark off a block of text so we can apply special formatting to it. Try adding “div” tags as follows. These contain style information, which we will explain later.

	 [Introductory DOCTYPE, HMTL, HEAD, META, and TITLE tags, get this from above or your previous exercises]

<BODY>

<H1>My Incredible</h1>

<div style="text-align:right">

<h2>Wonderful</h2>

<H3>well, kind of neat</h3>

</div>

<div style="text-align:center">

<H4>actually, rather ordinary</h4>

<H5>pretty lame, to be honest</h5>

</div>

<H6>World-Wide Web Page</h6>

<P>Hey Look! I'm a Web page!</P>

</body>

</html>
	You should see something like the mess below.

Can you see how the two pairs of <DIV> and </DIV> tags produce the blocks of centered and right-aligned text?

Try changing the width of the browser window. You will notice that the text blocks slide back and forth, preserving their alignment.
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Close and reopen DOM Inspector. You should see the div elements containing the heading elements. Save your headings example file as Headings.html and start a new text document.
Template Information / Numbered and Unnumbered Lists
The first four or five lines of our HTML pages will not change much (except the TITLE tag information).  Thus, to save space, from now on when we say “template information” or [Introductory DOCTYPE, HTML, HEAD, and META tags], we mean these lines:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/TR/html4/strict.dtd">

<HTML>

<HEAD>

<META http-equiv="Content-Type" content="text/html; charset=utf-8">

During our exercises, feel free to copy these lines from this document.

Copy the template information from the first few lines of the previous example file or this document. Enter the following HTML code to produce an unnumbered list, and save it as Lists.html.  
	            [Introductory DOCTYPE, HMTL, HEAD, and META tags]

<title> List Examples</title>

</head>

<body>

<h1>Dr. Dan’s Hobbies</h1>

<ul>

     <li>Bicycling</li>

     <li>Home Brewing</li>

     <li>Tormenting Students</li>

</ul>

</body>
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Here the UL (unnumbered list) tag contains three LI (list item) tags. The tags are properly nested – each <LI>tag is closed by a </LI> tag before the <UL> tag is closed with a </UL> tag.

Let’s expand the third list item, “Tormenting Students,” to contain a numbered list of the ways Dr. Dan enjoys tormenting his students. Note the complex nesting here: the ordered list (OL), together with all the list elements (LI) contained in it, must be complete before the third list element in the unnumbered list element is closed off.  The changes you need to make are highlighted below:

            [Introductory DOCTYPE, HMTL, HEAD, META, and TITLE tags]

<body>

<h1>Dr. Dan's Hobbies</h1>

<ul>

     <li>Bicycling</li>

     <li>Home Brewing</li>

     <li> <!—- starting third UL list element  -->

Tormenting Students

         <ol>

            <li>Incomprehensible lectures</li>

            <li>Cryptic lab assignments</li>

            <li>Midterm on Friday before Spring Break</li>

          </ol>

     </li> <!-- ending third UL list element -->
</ul>

Here we have inserted HTML comment tags, for example

<!-- starting third UL list element  -->

These tags have no effect on the page as it is displayed by the browser, but are intended to help Web developers like you understand the convoluted code involved. The changes you made should produce a [image: image27.png]


numbered list inside the third list item of the unnumbered list (see right).

List attributes

HTML tags can also contain attributes, which are special modifiers to control how a tag displays its contents. For example, the numbered list displays its items as “1”, “2”, and “3”. To get a different numbering, change the <ol> tag to look like this:

<ol type="A">

-- note that the attribute must fit inside the angle brackets that define the tag. Save the file and refresh the display – you should see the three numbered items shown as “A”, “B”, “C”.  As evil as it may seem, some HTML attributes are NOT valid.  If you validate your page, you’ll see some validation errors about the TYPE list attribute.  We’ll learn more about alternative styles with the CSS section later on in the Lab series.
Using an online reference

What if you wanted to use Roman numerals “I”, “II”, and “III” instead? It’s easy if you know where to look! In your Web browser, open a new window using the File/New menu item. Point the second window at the following link, offered as a public service by Brian Wilson:

http://www.blooberry.com/indexdot/html/index.html
Since we are interested in the properties of the OL tag, click Element Index, then O, then OL. Scroll down to the TYPE list attribute information and find where it tells how to make the numbered items displayed as Roman numerals. Can you make it work in your code? Remember that you must maintain the syntax

<ol type="value">

This is my single favorite online HTML reference. I use it more than any book.

Tables

HTML tables are used for two main reasons:

1. You actually have a table of some kind, such as a daily schedule

2. You want to lay out a page where elements appear side-by-side

Here’s an example of the first reason. Carefully type in the following HTML code, and save the result as table1.html:
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Here the TABLE element contains a collection of TABLE ROW (TR) elements. Each TR element contains either a bunch of table header (TH) elements or table data (TD) elements. Each of these table cell elements contains the actual contents of a table row. The result should look like this in your browser:

Note that the two entries for the Friday column (sleep) are the same. We can use the rowspan attribute to combine these two cells. Make the changes shown below by first adding the rowspan attribute in the 1st period, and then removing the second ‘sleep’ cell from the 2nd period row.  The rowspan allows us to have one cell take up multiple rows.  There is a similar attribute colspan for taking up multiple columns.
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Save the altered file as table2.html  and view it with your browser. The result should be as shown below.
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Now, modify this example to display your own actual class schedule.  You do not need to create your entire schedule, but at least add two more new rows to the table.  Try doing this without copying and pasting, as you may need to create a table from scratch during the quiz (Remember to start and end each row with the TR tag, and start and end each cell within the row with the TD tag).  To avoid extreme frustration, save and view your page after you have entered each new row.

More HTML Goodies

Now that you are used to the idea of HTML tags, let’s look at a Web page which contains several new ones. This time, we will get the page from the Internet.

Open the Mozilla Firefox browser (make sure you use Firefox for this next part) and type the following Uniform Resource Locator (URL) into the browser address box:

http://www.cs.uga.edu/~dme/csci1100/kutesy.html
After examining the page, use the browser View menu and choose Page Source. See if you can connect the visual display to the HTML tags that produce it. Ignore the style tag for now.

Aside from a rather twisted sense of humor, this page demonstrates several useful new HTML tags:

· The image tag <IMG src="koala2.gif">

· The boldface tags <B> and </B>;

· The italic tags <I> and </I>

· The paragraph tag <P>

· The anchor or hyperlink tag <A>, which takes you to another Web page.

Note that the IMG tag is not a container – there is no </IMG> tag. There is also a style tag in the head of the document. We will explain this tag below.

The src (source) attribute of the IMG tag gives the name of the image file that contains Kutesy’s picture. The href attribute of the A tag gives the location of the page to which you will be linked.

A multiple-file document

Let’s capture this page to our disk and look at it. 
1. From the Browser File menu, choose Save Page As, 
2. Change the “Save as type:” box to “Webpage, HTML only”. 
3. Save this HTML file in your I drive. 
4. Now go back to the Browser File menu and choose Open File. 
5. Browse for the kutesy.html file you have just saved. 

Ouch! Our adorable furry psychopath doesn’t show up!  The problem here is that the line 

<IMG src="Koala2.gif"> 

is only a reference to the image, Koala2.gif, which contains the actual picture. To fully capture the Web document, we need both files: the HTML source file and the GIF image file.

Click the Back button on Browser, which should return you to the original Kutesy webpage. Now point your mouse at the picture and click the right mouse button. This should bring up a menu, and choose Save Image As. Save it in the same folder as kutesy.html on your I drive. Now, use File/Open to look at kutesy’s webpage again. You should be able to view Kutesy’s adorable photo.

This is how an HTML document is used as a framework or container for media files. A complex Web page will actually consist of a number of separate files: the HTML container plus a separate media file for each image on the page. 

Hypertext links

Go back to Kutesy’s HTML code in Notepad2.  Let’s look at the cryptic line

...this list of my <A href = "movies.html">favorite movies!</A>

This is a hypertext link, the most important part of HTML. When you view the page, all that you see is the link text, favorite movies. Clicking on this hyperlink tells your browser to jump to the linked page. The World-Wide Web is a vast network of pages connected by links just like this.

A Busted Hyperlink

Try clicking on the link in the saved version of this page. You get an error message saying the page is not found. Bummer!

In fact, this is the same problem which we just had with the image. The link points to a file named "movies.html," which is stored on the server but not on our disk.

Go back to the Internet version of Kutesy’s home page, and follow the link to Kutesy’s movie page. Use the File / Save Page As method to download Kutesy’s movie page. And don’t forget to download the terrifying Jurassic Park graphic!

Now that we’ve saved the movie page, go back to your saved version of Kutesy in the browser, and mMake sure that the link from Kutesy’s main page on your I: drive now works.

Validating the Kutesy page

Try validating the Kutesy page at http://validator.w3.org. You should get the following error:
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This is very common error with old HTML code. In the old days, authors used HTML attributes to control style features, in this case centering the text in the browser window. Nowadays, we use only CSS for style features. You can fix this code by replacing the old align attribute with its modern equivalent, the CSS text-align property:

<div style="text-align:center">

The second error message may look a bit more cryptic:
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This error message uses the vocabulary words attribute and element. If you’re comfortable with the vocabulary words, you can see that the validator wants you to add the ALT attribute. Go to browser window, navigate to the blooberry website (http://www.blooberry.com/indexdot/html/index.html) and look up the IMG tag in the Element Index. You will find that the ALT attribute consists of text to be displayed when the browser cannot handle the IMG tag. This might occur if the image file is missing, or the user is blind and using software to read the page to him/her.

Return to the source for Kutesy’s main page in Notepad2, and look at the IMG tag. So far this tag has one attribute, SRC, which represents the name of the image file. Add another attribute ALT, whose value should be “A furry terrorist”. Remember that the ALT attribute goes inside the brackets that define the IMG tag and that its grammar will look just like the grammar for the src attribute. In other words, the new tag will look something like this:

 <img src="koala2.gif" alt ="insert caption here"> 

-- where you replace "insert caption here" with "A furry terrorist", or whatever caption you’d like. If you save your changes and refresh the page, right click on the image of the koala and go to properties.  You should see a section that says “Alternate text:” with your caption in it.

A complete HTML tag reference

As you can see, learning HTML is largely a matter of mastering one tag after another. You know what you want to do, find the tag that does the job, and look at the reference to see how it works. Here once again is my favorite HTML online reference:

http://www.blooberry.com/indexdot/html/index.html
Cascading Style Sheets (CSS)

Now we have learned a bit about using HTML to lay the page elements out on your page. The other part of Web authoring is styles, which define the format of the page elements. Go back to Notepad2 and examine the style tag in the head part of the kutesy.html document:

<style type="text/css">

P {font-family:Arial}

BODY {background-color:white}

</style>

This style says that all paragraphs (P tags) should be in the Arial font-family, and that the BODY element should have the background color property set to white.

· Edit this style to also set the H1 element to use the Arial font-family. You can do this by adding another line, just like the “P” line except starting with “H1”.

· Now edit the style tag so that P elements use the “cursive” font family. Check out the result: it should look more hand-written. Try out the “courier” font family.

· Now edit the style tag to change the BODY background color to lightyellow. Check out the result.

Use your second browser window (or open a second window if you don’t have one) and go to the color chart at 

http://html-color-codes.com/
These colors are considered web-safe, meaning they should look the same on every browser. (It’s a bummer to choose a lovely color scheme and have it look different on your users’ screens!) The colors are given in hexadecimal (base-16) format (we won’t require you to translate to decimal!) Use the “#” prefix to specify these colors in a style tag, like this:

 BODY {background-color:#6699CC}

Try out this and a few other background colors on your page.

Font sizes and colors

Aside from the font-family, you may also want to change the size or color of your font. This style will make all paragraphs green with 14 point fonts:

P {font-size:14pt;color:#00FF00}

· Modify this to make your P elements use Verdana font-family, have 18 point font,  color #CC6633, and background color #33CCFF? I warn you, this is going to look pretty weird!

· Now set it back to somewhat normal with Arial font-family, color black, and 12pt font.

Style classes for distinctive formatting

Sometimes you want to make some, but not all elements have a particular style. For example, a paragraph with especially important information might be put into a different colored font. One way to do this is to define a specialty style class. You can choose any name you like for this class (we chose special, but it could be anything), but it must be represented in the style tag starting with a period. Try putting this code into your style tag:

   .special {font-size:16pt; color:#FFFFFF}

Then, scroll down to Kutesy’s third paragraph, about his nefarious plan to rid the world of humans, and apply the “special” font by giving that paragraph the ‘class’ attribute, like this:

   <p class='special'>Well, I gotta go...</p>

Check out the result. Note that the special font color is white, so it won’t show up unless the page background color is not white. Also note that attributes such as ‘class’ and other attributes are always defined inside the tag they apply to, but you never need to put attributes into closing tags such as the </p> tag.

Styles for tables and table cells

Styles can be very useful to brighten up your tables and make them easy to read. Use Notepad2 to your student schedule page (table1.html). The style tag will both go inside the HEAD section, which contains the TITLE and META tags. It looks like this:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN"

            "http://www.w3.org/TR/html4/strict.dtd">

<HTML>

<HEAD>

<META http-equiv="Content-Type" content="text/html; charset=utf-8">

<TITLE>CSCI 1100 Web page Example</TITLE>

<style type="text/css">

...style definitions will go here

</style>

</HEAD>

<BODY>

· Replace the placeholder text “… style definitions will go here” with a style which gives all the TH (table column header) elements a distinctive font and background color, such as a light font on a dark background.

Another way to improve tables is to give the table cells a bit of padding, or room around their contents. Try adding this to your style tag:

  TD {padding-left:12px}

You should find that your table cells all have a bit of space to the left of their contents. 
· Add padding to the top, right, and bottom of your table cells using the padding-top, padding-right, and padding-bottom properties respectively.  Remember you can separate styles applied to the same element with a semicolon (look back at previous examples to see the use of the semicolon).
Master Index of CSS properties:

As with HTML tags, I rely on Brian Wilson’s excellent reference site for CSS at 

http://www.blooberry.com/indexdot/css/index.html
Browsing this index, you will discover a wealth of cool tricks to play with your Web pages.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/TR/html4/strict.dtd">


<HTML>


<HEAD>


<META http-equiv="Content-Type" content="text/html; charset=utf-8">


<TITLE>CSCI 1100 Web page Example</TITLE>











[Introductory DOCTYPE, HMTL, HEAD, META, and TITLE tags]





<body>


<h1>My Summer 2008 Class Schedule</h1>


<table border=1>





<tr>


<th>Period</th><th>Monday</th><th>Tuesday</th><th>Wednesday</th><th>Thursday</th><th>Friday</th>


</tr>





<tr>


<td>1st</td><td>Sleep</td><td>Breakfast</td><td>CS Lab</td><td>Breakfast</td><td>Sleep</td>


</tr>





<tr>


<td>2nd</td><td>Breakfast</td><td>HIST 2112</td><td>CS Lab</td><td>ENGL1102</td><td>Sleep</td>


</tr>





</table>


</body>





[Introductory DOCTYPE, HMTL, HEAD, META, and TITLE tags]





<body>


<h1>My Spring 2008 Class Schedule</h1>


<table border=1>


<tr> 


<th>Period</th><th>Monday</th><th>Tuesday</th><th>Wednesday</th><th>Thursday</th><th>Friday</th>


</tr>


<tr>


<td>1st</td><td>Sleep</td><td>Breakfast</td><td>CS Lab</td><td>Breakfast</td><td rowspan=2>Sleep</td>


</tr>





<tr>


<td>2nd</td><td>Breakfast</td><td>HIST 2112</td><td>CS Lab</td><td>ENGL1102</td><td>Sleep</td>


</tr>


</table>


</body>








